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Welcome to DC 2000Welcome to DC 2000Welcome to DC 2000Welcome to DC 2000    

Welcome to Metretek’s DC 2000 System. DC 2000 is Metretek’s newest data 

collection, processing, and reporting system. This powerful suite of applications, 

operating in a Windows NT-based environment, provides you with all the tools you 

need to collect, process and report on your valuable data. 

 

This Getting Started booklet will: 

� Show you how to start DC 2000, find applications and open applications 

� Familiarize you with the DC 2000 interface 

� Show you how to get help 

� Help you get started in completing some basic system and reporting tasks 

New to Windows 95/NT?New to Windows 95/NT?New to Windows 95/NT?New to Windows 95/NT?    

If this is your first exposure to Windows 95 and NT, we suggest that you consult 

your user documentation and familiarize yourself with these new interfaces. 

Becoming familiar with the interfaces will speed up your ability to navigate the 

system and accomplish basic tasks, such as disk copying and file viewing. There are 

also a number of third party books and informative web sites that can provide you 

with helpful information. 

 

For Metretek PC6 usersFor Metretek PC6 usersFor Metretek PC6 usersFor Metretek PC6 users    

If you’ve used Metretek’s PC6 system, here’s how DC 2000 references similar 

terminology: 

    AIS Number vs. Remote Unit ID AIS Number vs. Remote Unit ID AIS Number vs. Remote Unit ID AIS Number vs. Remote Unit ID     

In PC6, you assign a unique AIS number to each Remote Unit. In DC 2000, you 

assign a unique Remote Unit ID, (RU ID), to each Remote Unit. 

Merge Account vs. Account Merge Account vs. Account Merge Account vs. Account Merge Account vs. Account     

In PC6, you use a Merge Account to reference a number of Remote Unit inputs. In 

DC 2000, you use an Account. 

Group vs. List Group vs. List Group vs. List Group vs. List     

In PC6, you use a Group to reference a number of Accounts. In DC 2000, you use a 

List. 
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Save Screens vs. Images Save Screens vs. Images Save Screens vs. Images Save Screens vs. Images     
In PC6, you use Save Screens to save a report for later use and autoloading. In DC 

2000 you save an Image. 

Hardcopy and Gas Package Reports vs. Custom Report Hardcopy and Gas Package Reports vs. Custom Report Hardcopy and Gas Package Reports vs. Custom Report Hardcopy and Gas Package Reports vs. Custom Report 

Application Application Application Application     

In PC6, you configure and run the Hardcopy or Gas Package reports. In DC 2000, 

you use the Custom Report application to create custom reports. DC 2000 also 

includes the Autoload process, allowing you to autoload reports 

Starting DC 2000Starting DC 2000Starting DC 2000Starting DC 2000    

1. Double-click the DC 2000 icon: 

The DC 2000 Logon dialog box appears: 

 

2. Enter your User Name and Password. 

3. Click OK. 

The Application Groups dialog box, (DC 2000 Launcher), appears. This is 

where you open applications. 
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The Application Groups Box (DC 2000 Launcher)The Application Groups Box (DC 2000 Launcher)The Application Groups Box (DC 2000 Launcher)The Application Groups Box (DC 2000 Launcher)    

The Applications Group dialog box (DC 2000 Launcher) is your gateway to the 

system. All DC 2000 applications and main system processes are available here, 

identified with an associated icon and conveniently grouped in folders. The online 

help system is also available here, so you can investigate an application before you 

begin using it. 

 
 

 

 

 

 

 

 

Click to minimize the 

Application Groups 

box and place it in the 

taskbar. 

Click to open the folder 

and display all the  

available applications.  

Click to close all 

applications and shut 

down DC 2000. 

Click to access the 

online Help system. 

Double-click to open 

the application. 
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The Application Main WindowThe Application Main WindowThe Application Main WindowThe Application Main Window    

The main window appears when you first start an application. This is where you 

initiate basic tasks such as adding, editing, and removing report images, accounts, 

remote units and autoloads.  

An application’s main window always includes the following elements: 

 
 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Metretek logo Name of the application 

Application icon 

Menu bar with File,  

Data, and Help 

drop-down menus 

Toolbar 
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The ToolbarThe ToolbarThe ToolbarThe Toolbar    
 

A toolbar is a panel that contains a set of controls, (usually buttons), designed to 

provide quick access to specific commands or options. The DC 2000 Toolbar  is 

displayed on the main window of each application, and consists of a palette of 

buttons that enable you to accomplish basic application functions. The complete 

set of five buttons is displayed in each application; however, if a particular 

function is not provided, the corresponding toolbar button appears dimmed and is 

unavailable. 

 

Each application toolbar includes the following buttons: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

    

    

Click to Print a report, 

list, or configuration. 

    

Click to Add a report, 

process, or configuration. 

Click to Edit a report, process, or 

configuration. 

Click to Delete a report, 

process, or configuration. 

Click to Run a 

report or process. 
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The Menu BarThe Menu BarThe Menu BarThe Menu Bar    
 

The menu bar is the area directly below the title bar and above the toolbar. This 

area displays menu titles that, when selected, open drop-down menus that provide 

you with access to some of the DC 2000 application and system options. Some of 

the drop-down menu choices are also found on the toolbar. Three drop-down 

menus – File, Data and Help – and their choices are found on the menu bar in 

each application; however, if the options for a particular drop-down menu are not 

provided in an application, the corresponding title appears dimmed and the menu 

is unavailable. 

 

Each application menu bar includes the following: 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click to Print a report. 

Click to open Preferences, where you can 

set up system defaults for displaying 

Remote Units, edited data, etc. 

Exit and close the application. 

Click to Add a report, process, or configuration. 

 

Click to Edit a report or process, or configuration. 

Click to Delete a report, process, or configuration. 

 

Click to access the main help Contents page for the application. 

Click to access information on how to effectively use DC 2000 

help – tips on copying, printing, etc. 

Click to open a dialog box displaying the version and name of 

the application you are using. 
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The Edit Dialog BoxThe Edit Dialog BoxThe Edit Dialog BoxThe Edit Dialog Box    

The Edit dialog box is displayed when you choose to add or edit a report, process, or 

configuration. Each Edit dialog box provides all the tools you need to accomplish 

application-specific tasks.  

Tabbed Pages Tabbed Pages Tabbed Pages Tabbed Pages     
DC 2000 uses tabbed pages in many dialog boxes. Each tabbed page groups similar 

options, thereby simplifying your setup, editing, and configuration tasks. You will 

find that certain groups of applications offer similar tabbed pages. For example, all 

Reporting applications include the Where tab (see illustration below) that provide 

options allowing you to specify the format, destination, file name, and font for a 

report. 

Name of the report image, 

process, or configuration 

on which you’re working. 

Command Buttons 

Tabbed Pages 
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Command Buttons Command Buttons Command Buttons Command Buttons     

A command button is a rectangular “push button” that carries out a command and is 

located in a dialog box. One or more of the following command buttons is found in 

each Edit dialog box:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Closes the dialog box and saves all changes you have 
made. 

Cancels any process you have initiated and closes the 
dialog box. 

 
Displays the main help page for the dialog box. 

Found in the Multi-Member application – applies an 

image configuration to an Account or a List. 

Saves any changes you have made without exiting the 
dialog box. 

Found in the Daily Read Build application - generates the 
selected daily read build. 

Clears, (depending on the application), specified data or 
items from a list. 

 
Generates a report when you click the button. 

Allows you to view generated information without 

printing. 

Closes the current dialog box without saving any changes 
you have made.  
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Found in any application that can be autoloaded. Opens 

the Autoload Scheduler application where you set up the 
autoload. 

Allows you to apply changes, such as adding a call 

window in the Call Configuration application, and then 

continue working in the active dialog box. 

 

These buttons enable you to add or remove a process 

or function in an application. For example, in the 

Remote Unit Configuration application they allow you 
to add and remove remote unit inputs. 

 

This trio of buttons (Move, Cut, and Paste) is found in the 

applications where two lists are displayed. The buttons 

enable you to reorder a list, by "cutting" and "pasting," and 
copy (Move) selections from one list to the other. 

Found in the Data Resynchronization application –  this 

button allows you to "preview" the resynchronized data 
before you save the changes to your database.  

Found in the Dial Out application –  this button initiates 

the "dial out" process. (initiate a call from an Account 
or a List). 
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Metretek Search EngineMetretek Search EngineMetretek Search EngineMetretek Search Engine    

DC 2000 includes a utility that makes searching for a particular Remote Unit, 

Account, or List much faster and easier - the Metretek Search Engine. This powerful 

utility enables you to sort and search lists of Available Remote Units, Available Lists 

and Available Accounts by any predefined field you choose. The three Search Engine 

controls are located directly above each list.  

 

In the example below, the user is searching list of Available Accounts for all 

Accounts with an Account ID beginning with 002 - such as 00200A, 002001, 002002, 

etc. Here’s how the search was set up: 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As you can see in the example, the list of Available Accounts is reordered and 

displayed as specified by the specified search criteria.  

 

 

 

 

Click to initiate the Search. Click the arrow to select the 

field to Use for the search. 

Specify what your are going to 

Search for in the Use field. 

NOTE:NOTE:NOTE:NOTE: You can initiate a sort by simply selecting a new 

Use field by which to reorder the list. 
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How to Get HelpHow to Get HelpHow to Get HelpHow to Get Help    

As you become acquainted with DC 2000, you will probably want more information 

on the applications and accomplishing tasks. There are three ways for you to get this 

information: 

1. Context-Sensitive Help 

2. Online Help 

3. Metretek Technical Support Help 

Context-sensitive and online help are always available from your workstation, and 

Metretek Technical Support Help is available by telephone or email. 

Online Help                                                   Online Help                                                   Online Help                                                   Online Help                                                       
The Main Help page for the application and dialog box you are using is available: 

� From the Help drop-down menu located on the Menu Bar of each DC 2000 

application’s Main Window (see The Menu Bar, page ). 

� By clicking the Help button on the application’s Edit dialog box (see The Edit 

Dialog Box).  

The Main Help Page The Main Help Page The Main Help Page The Main Help Page     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the solid underlined 

text to view a related topic. 

Click to view an 

application overview. 

Click to view a list of 

detailed How Do I? tasks for 

the application. 

Click to access the DC 2000 

HelpTopics dialog box. 

Click to access the 

DC 2000 glossary 

of terms and 

concepts. 

Click the dotted underlined text to 

view a popup definition. 
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The DC 2000 Help Topics Dialog Box The DC 2000 Help Topics Dialog Box The DC 2000 Help Topics Dialog Box The DC 2000 Help Topics Dialog Box     

Access the DC 2000 Help Topics dialog box by clicking the Help Contents button on 

the application’s main help page. The Help Topics dialog box allows you to access 

information on all the applications and provides an easy way to view and print any of 

the extensive library of How Do I? tasks. This handy printing feature enables you to 

create your own personalized manual!  

 

 

 

 

 

 

Click to Display the 

topic you have typed 

or selected from the 

index list. 

Choose a word 

from the Index 

word list. 

Type and the Index word 

list automatically scrolls to 

the closest match. 

Closed Configuration 

Applications book. 

Open Configuration 

Applications book. 

Double-click to display 

the Topic page. 

Click to print a selected 

Topic page or all pages 

in a Book. 
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DC 2000 ContextDC 2000 ContextDC 2000 ContextDC 2000 Context----Sensitive HelpSensitive HelpSensitive HelpSensitive Help    
Context-sensitive help is a form of assistance that displays on-screen information 

about the current command or operation you are attempting. This is very useful when 

learning to use DC 2000 applications and the many features, since the information is 

immediately available by pressing the F1 key. DC 2000 includes context-sensitive 

help for all dialog options, including check boxes, buttons, tabs, and drop-down lists.    

    

    

    

    

    

    

Metretek Technical SupportMetretek Technical SupportMetretek Technical SupportMetretek Technical Support    
There are two ways for you to get help through Metretek Technical Support. The one 

you choose should depend on the severity of your problem: 

� If you have a critical problem that requires immediate attention, call Metretek 

and ask for your Technical Support representative.  

� If you have a less serious problem, suggestion for a feature (we save suggestions 

in a “Customer Wish List” file for consideration in future releases), or wish to 

report some idiosyncrasy in an application you can visit our web site and send 

us an email. To do so follow these steps: 

1. Type http://www.metretek.com in your browser Address box and press Enter. 

2.  Click Support in the title bar. 

3. Enter your Username and Password. If you are not a registered user, click 

registration form and enter the required information. Click DC 2000. 

4. A pre-addressed email form appears. Compose your message and click the send 

(letter) button. 

Context-sensitive “popup”   

help displayed after selecting 

the Existing data checkbox 

and pressing F1.  
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The message is sent to Metretek Technical Support, the problem/suggestion is 

assessed, and you receive a prompt reply. 
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Accomplishing TasksAccomplishing TasksAccomplishing TasksAccomplishing Tasks    

To get you started, we’ve included instructions on how to complete some basic tasks. 

These tasks are taken from the DC 2000 online help system to help you become 

familiar with the way the help is written. You can view these tasks online by: 

� Clicking the Using (name of the application) to…and double-clicking a task in 

the list 

� Double-clicking the Tasks You Can Accomplish Using the… book on the main 

Help Topics dialog box, then selecting and double-clicking the name of the 

application book for which the task is written, and finally selecting and double-

clicking the page (task) you want to view.  

 

 

 

 

How Do I Add a Remote Unit?How Do I Add a Remote Unit?How Do I Add a Remote Unit?How Do I Add a Remote Unit?    

1. Open the Remote Unit Configuration application. 

2. In the Available Remote Units list, select the Remote Unit from which you wish to 

copy information. 

3. Do one of the following: 

� Click the Add icon. 

� Select Add from the Data menu. 

The Add Remote Unit dialog box appears. 

4. In the New Remote Unit ID box, enter the new Remote Unit ID. 

5. Select the Copy Remote Unit ID check box. 

The remaining fields are filled with the information from the selected Remote 

Unit.  

6. Click OK. 

 

 

 

 

 

 

NOTENOTENOTENOTE: you can also print a task without viewing it by selecting the page 

(task) and clicking the Print Print Print Print button located at the bottom of the Help 

NOTENOTENOTENOTE: You can also add a Remote Unit, (without using an existing one for 

the default information), and specify new product type, battery type, and 

call profile information. However, unless you are adding a new Remote 

Unit type, you will usually add a new Remote Unit similar to an existing 
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How Do I Schedule Remote Units to Call into the System?How Do I Schedule Remote Units to Call into the System?How Do I Schedule Remote Units to Call into the System?How Do I Schedule Remote Units to Call into the System?    

 

 

 

 

 

1. Open the Call Configuration application. 

2. In the Call Profile ID box, click the arrows and select the Call Profile you want to 

schedule. 

3. Do one of the following: 

� Click the Edit icon. 

� Select Edit on the Data menu. 

The Edit Call Profile dialog box appears. 

4. Click the Call Spacing tab and set up the call spacing and define the call period. 

5. Click the Daily Call Window tab to setup and remove daily call windows. 

6. When you have finished editing the selected call profile, click OK. 

7. The Call Configuration main window appears. 

8. Click the Run button. 

The Call Schedule Preview dialog box appears. 

9. Click OK. 

 

 

NOTENOTENOTENOTE: Before you can schedule Remote Units to call into the system, they 

must be assigned to a Call Profile. This is usually done when you add a 

Remote Unit to the system, using the Remote Unit Configuration 
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How Do I Synchronize DC 2000 with a Remote Unit?How Do I Synchronize DC 2000 with a Remote Unit?How Do I Synchronize DC 2000 with a Remote Unit?How Do I Synchronize DC 2000 with a Remote Unit?    

  

Get the latest Time of Call reading from the Remote Unit you are resynchronizing. 
 

1. Open the Data Resynchronization application. 

2. In the Available Remote Units list, select the Remote Unit you want to 

resynchronize. 

3. The Inputs for the selected Remote Unit are displayed in the Selected Remote Unit 

Inputs list 

4. In the Selected Remote Unit Inputs list, select the inputs you want to resynchronize. 

5. In the Start Date and End Date boxes, specify the period over which to view the 

Time of Call readings for the selected inputs.  

 

6. Click            (Run button).  

 

The Time of Call Adjustment for dialog box appears. 

7. Click the Time of Call tab and examine the displayed list of readings. After you 

have determined the period over which to resynchronize and the starting point, do 

the following: 

� Under Adjust Direction, specify the direction, from the starting point reading, 

to resynchronize the readings. 

� The Adjust FORWARD from: label is displayed as Adjust BACKWARD 

from: if you select adjust “Backward.” 

� In the Time of Call Readings list, select the reading to use as the starting point 

for the resynchronization process, and click the Set button located next to the 

Adjust FORWARD or BACKWARD from: box. The selected reading is now 

displayed in the box. 

� In the Time of Call Readings list, select the reading to use as the ending point 

for the resynchronization process, and click the Set button located next to the 

Adjust through box. The selected reading is now displayed in the box. 

8. In the Time of Call Readings list, double-click the reading you selected as the 

starting point. (Be sure to double-click the "Input Reading" column). 

The Reading Change dialog box appears. 
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9. In the New Reading box, enter the new Time of Call reading.  

� The Time of Call Adjustment dialog box appears.  

� The adjusted reading is displayed in the list with a “R” in the associated 

“Status” column.  

� The Preview button is enabled. 

10. Click Preview. 

The Time of Call Readings list is reordered and: 

� All resynchronized readings are adjusted to reflect the new readings (the 

DELTA between each pair of columns is calculated and added to the next 

column) 

� All resynchronized readings are displayed in the color you have specified in 

Preferences (), and the status is set to “A.” 

 

 

� The date and time for all resynchronized readings are displayed in blue text. 

11. If you want to adjust the Intervals: 

 Click the Interval tab and select Adjust Intervals. 

12. Click OK 

� The Time of Call readings are resynchronized 

� The Intervals are adjusted (if you chose to adjust), and  

� The database is updated accordingly. 

 

DC 2000 system preferences are available in each application from 

the File File File File menu. The Color of edited data optionColor of edited data optionColor of edited data optionColor of edited data option is found on the 



PagePagePagePage    Getting Started With DC 2000!Getting Started With DC 2000!Getting Started With DC 2000!Getting Started With DC 2000!    
 

Metretek, Inc.Metretek, Inc.Metretek, Inc.Metretek, Inc.    

19 

How Do I Set Up My PC6How Do I Set Up My PC6How Do I Set Up My PC6How Do I Set Up My PC6----Type Reports?Type Reports?Type Reports?Type Reports?    

 

To set up PC-6 type reports, you will complete two main tasks: (1) Choosing and setting 

up a Layout and (2) Choosing and setting up an Image. DC 2000 includes layouts that are 

configured for the following PC6-type reports: 

 

1.3 Daily Meter Reading  1.9 Daily Meter Readings/Billing 

1.4 Time-Tagged Interval  1.10 Detailed Daily Readings 

1.6 Meter Readings/Billing GP.1 AIS Calendar  

1.7 Detailed Meter Reading GP.2 Tabular Usage 

1.8 Total Consumption  GP.5 TTI Lotus Interface 

 

PART I: Choose and set up the Layout: 

1. Open the Custom Report application. 

2. Select the Layouts option 

3. In the Available Layouts list, select the layout for the report you want to copy, and 

click the Add icon. 

The Add Layout dialog box appears. 

4. In the New layout name box, enter a name for the layout.  

5. Select the Copy from Layout check box and click OK.  

The Edit Layout dialog box appears. 

6. Now you'll set up the layout. Options are provided on three tab dialog boxes: 

� Configuration tab – The options on this tab enable you to specify the column 

information, the report format and the report data label. 

� Columns tab – The options on this tab enable you to configure the report 

columns. You can specify the type of data to calculate and display in the 

columns, set up custom column titles, and display special symbols and database 

fields in columns. 

� Header/Footer tab – The options on this tab enable you to configure a custom 

report header and footer to display on each page of the report. 

The default header and footer, set up in Preferences, are displayed when you 

add a new layout. When you are copying an existing layout, the header and 

footer for the layout being copied are displayed. 

7. When you have finished setting up the layout, click OK. 
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The Custom Report main window appears. 

 

PART II: Set up the Image: 

1. Select the Images option 

2. In the Available Images list, select an image that is setup similar to the one you 

want to use, and click the Add icon. 

The Add Image dialog box appears. 

3. In the New image name box, enter a name for the image (you may want to use the 

same name as the layout you created in Part I).  

4. In the Use Layout box, click the arrow and select the layout you set up in Part I. 

5. Select the Copy from image check box and click OK.  

The Edit Image dialog box appears. 

6. Now you'll set up the image. Options are provided on three tab dialog boxes: 

� Where tab – The options on this tab enable you to specify: where the report is 

sent, the report format (file type and font), and the application to use when 

automatically opening a generated report. 

� What tab – The options on this tab enable you to choose the Account or List on 

which to report. 

� When tab – The options on this tab enable you specify the report period. 

7. Click Save. 

 The report image is saved. 

The specified report period is not saved with the image. If you are going to 

Autoload the report, you will set up the report period in the Autoload Scheduler 

application.  

8. Do one of the following: 

� Click Autoload to set up your report for an Autoload 

� Click Print to immediately run the report. 

� Click Close to exit the Edit Image dialog box. 
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How Do I View Daily Read, Interval, and Time of Call Data?How Do I View Daily Read, Interval, and Time of Call Data?How Do I View Daily Read, Interval, and Time of Call Data?How Do I View Daily Read, Interval, and Time of Call Data?    

1. Open the Data Viewer application. 

2. In the Available Accounts list, select the Account for which to view data. 

3. In the Account Members list, select the Account member for which to view data. 

4. If you want to view data for all the Account Members, click Select All. 

5. Click the Clock and Calendar buttons and specify starting point for the period over 

which to retrieve data for viewing (the end date and time is the present date).  

6. In the Data Type list, click the arrow and select the data type you want to view: 

� Interval 

� Time of Call 

� Daily Reading 

7. Click the Run button. 

A dialog box for the selected Account Member and data type appears.  

If you chose to view data for ALL the Account Members, (by clicking Select All), a 

dialog box for each Account Member appears.  

 

 

 

8. Close the Data Viewer application in any of the following ways: 

� Selecting Exit on the File menu. 

� Pressing Alt + F4. (You can use this for any open dialog box) 

� Clicking the X in the upper right corner of the dialog box. 

 

 

NOTE: NOTE: NOTE: NOTE: To view another data type, select the Account Member(s) 

you want to view, select the data type, and then click RunRunRunRun. You can 
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How Do I Set Up and Schedule an Autoload?How Do I Set Up and Schedule an Autoload?How Do I Set Up and Schedule an Autoload?How Do I Set Up and Schedule an Autoload?    

 

 

 

 

 

 

 

 

1. Open the Autoload Scheduler application. 

2. Choose the application you want to Autoload daily by selecting, (in the 

Applications Scheduled to Autoload list), the application and the associated report 

you have previously set up.  

3. Do one of the following: 

� Click the Edit Icon. 

� Select Edit from the Data menu. 

� Double-click the selected Autoload. 

The Setup Autoload dialog box appears. 

4. Under When, in the Frequency box, click the arrow and select Daily. 

5. Under When, in the Next scheduled run date and time boxes, click the calendar and 

time buttons and specify the next time you want the Autoload to run. 

6. Under How, in the Report period box, click the arrow and select Daily. 

7. Under How, in the Start date and time boxes, click the calendar and time buttons 

and specify the beginning of the report period.  

8. Under How, in the Stop date and time boxes, click the calendar and time buttons 

and specify the end of the report period. Generally, the start date/time and stop 

date/time are specified as 24 hours apart. 

9. Click OK. 

The Autoload report runs once a day and displays data for the previous 24 hours at 

its next scheduled run time. 

 

 

NOTE: NOTE: NOTE: NOTE: This example explains how to set up a previously configured 

report to Autoload daily. For example, most users Autoload a daily 
consumption report after all Remote Units have called into the 

system. It is important to remember that the report configuration 

does not happen in the Autoload Scheduler application – reports must 

be configured in their associated applications. The Autoload 
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How Do I How Do I How Do I How Do I Add a New User to the System?Add a New User to the System?Add a New User to the System?Add a New User to the System?    

1. Open the User Setup application. 

2. Do one of the following: 

� Click the Add icon. 

� Select Add from the Data menu. 

The Add User dialog box appears. 

3. In the User Name box, enter the new user's name. 

4. In the Password box, enter a password for the new user. 

5. Click the Calendar icon and use the controls to specify a password expiration date. 

6. In the Available Security Categories list, select a security category for the new user. 

7. Click OK. 
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How Do I Build Daily Readings?How Do I Build Daily Readings?How Do I Build Daily Readings?How Do I Build Daily Readings?    

1. Open the Daily Read Build application. 

2. In the Available Images list, select the previously configured report image you want 

to use to build the daily readings. (You can also add a new Daily Read Build report 

image - then configure and run it as described in steps 4 – 8.) 

3. Do one of the following: 

� Click the Edit Icon. 

� Select Edit from the Data menu. 

� Double-click the selected report image. 

The Edit Image dialog box appears. 

4. Click the What tab. 

5. In the Available Accounts list, select the Account for which to build the daily 

readings. 

6. Click the Build for tab. 

� Under Tag Data Status as, select how you want to label the rebuilt data. 

� If you want to wipe out the previous data readings, select the Overwrite existing 

readings check box. 

� If you want to suspend the daily read build process when the time of call 

reading is out of sync, select the Stop it time of call reading is out of 

synchronization check box. 

7. In the Rebuild start date box, click the Calendar icon and specify the start date, (the 

end date is the present date), for the period over which to build daily reads. 

 

 

8. Click Save, and then click Build. 

 

 
 

NOTE: NOTE: NOTE: NOTE: The daily readings are actually calculated from the present date 

back to the Rebuild start date. 
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How Do I Determine Which Remote Units Are Calling Late?How Do I Determine Which Remote Units Are Calling Late?How Do I Determine Which Remote Units Are Calling Late?How Do I Determine Which Remote Units Are Calling Late?    

1. Open the Overdue Call Report application. 

2. In the Available Images list, select the previously saved report image you want to 

use for the report. 

3. Do one of the following: 

� Click the Edit Icon. 

� Select Edit from the Data menu. 

� Double-click the selected Image. 

The Edit Image dialog box appears. 

4. Click the How tab. 

5. Under Overdue Based On, select the Last Call Time option. 

6. In the Reference date and time boxes, click  the calendar and clock icons and enter 

the date and time at which Remote Units are considered "overdue."  

7. Click Print. 

� If you have selected File on the Where tab, the Overdue Call Report status 

dialog box appears and your report is generated as you have specified under File 

Destination and File Type (on the Where tab). 

� If you have selected Printer or Both on the Where tab, the Print dialog box 

appears and you must go to Step 8. 

8. Click OK. 

The report is either: 

� Sent to the printer  

-OR- 

� Sent to the specified printer and printed to the specified file. 

 


